Assistive Computer Technology for Library Access

High Tech Center Training Unit
Of the California Community Colleges at the Foothill-De Anza Community College District

21050 McClellan Road
Cupertino, CA 95014
(408) 996-4636
(800) 411-8954

http://wwwv.htctulhda.edu
# Table of Contents

- Accessibility Control Panel Options (Win 95/98/NT) ........................................ 1
- Dragon NaturallySpeaking Preferred 4.0 (Win 95/98/NT) ...... .................. 5
- Duxbury Braille Translator ver. 10:2e (Win) ........................................... 11
- JAWS 3.5.37 for Windows (95/98/NT/2000) .............................................. 15
- JAWS 3.5.37 and Internet Explorer 5.0 .................................................. 43
- Kurzweil 1000 5.0 (Win 95/98/NT) ......................................................... 59
- Kurzweil 3000 4.0 (Win 95/98/NT) ......................................................... 63
- ZoomText Xtra 7.01 (Win 95/98) ............................................................ 67
Accessibility Control Panel Options (Win 95/98/NT)

Publisher: Microsoft Corp.
One Microsoft Way
Redmond, WA 98052-6399
(206) 635-7245
http://www.microsoft.com/enable

Retail Cost: Included in OS

System Requirements:
The Accessibility Options are found in the Windows 95/98/NT Control Panel which is accessed through Settings on the Start menu. The Accessibility Options are included in the default Windows 95/98/NT installation.

Description:
The Accessibility Options include five types of adaptive system support: Keyboard, Sound, Display, Mouse, and General. Note that there is no Display Tab on the NT Control Panel.

Recommended Uses:
The Options provide system support for: persons with physical difficulty in using the keyboard; persons who have visual disabilities and need larger print; stronger contrasts or larger mouse pointer; persons who are deaf or hard of hearing and need to see sound events; and, persons using a serial device to connect to the computer. What is singular about this cluster of operating system support is the fact that previously, almost all of these features had to be purchased from third party vendors.

Basic Use:
1. Enter Ctrl-Escape to bring up the Start menu.
2. Double Click on Accessibility Options. The Accessibility Properties window appears.
3. Click on a properties tab to go to a support feature.

The Keyboard Properties Tab
Three features: StickyKeys, FilterKeys, ToggleKeys are available; each has a settings window which is reached by clicking on a Settings button.

- StickyKeys
  Use sticky keys to latch the special keys (Ctrl, Alt) or the shift keys. When one of these keys is pressed, it latches and releases only when a second key is
pressed, e.g., Ctrl-P. Tapping shift or a special key twice latches it down (e.g., to type many asterisks); tapping it again will unlatch it if that option has been set. This feature is used when the keyboard user is unable to hold two keys down at the same time.

The keyboard shortcut to turn sticky keys on is to tap the Shift key 5 times. There are additional options which may be selected for the StickyKeys feature: turn off StickyKeys when two keys are depressed at the same time (automatically turning the feature off for a regular typist), make a sound when a special key is pressed, and a very important feature, the ability to show a visual display of whether a special key is latched or not (not available in NT). Having the visual display on the screen is useful information for persons with short term memory deficits. Right clicking on this reminder brings up an option to adjust settings.

- **FilterKeys Properties Tab**
  
  There are two types of options which may be set from the main FilterKeys property sheet. The one most frequently used is the second radio button option. This controls the function of RepeatKeys and SlowKeys.

  1. **RepeatKeys**
     
     This option will override settings on the Keyboard control panel. It is possible to turn off keyboard repeat entirely, or is it possible to slow down the rate at which the key repeat function repeats. Students with slow visual processing speeds benefit from a slowed key repeat function because it is easier to track the cursor. Students who are unable to quickly lift their hands off a key will benefit from having the repeat delay increased (a finger can stay on a key a bit longer before a key repeat begins).

  2. **SlowKeys**
     
     The SlowKeys function allows the user to set a time delay before a keystroke is registered. This in effect can create a virtual keyguard for the student who strikes many keys while moving over the keyboard to the target keystroke. No keystroke will be registered until a key has been depressed for a minimum length of time.

The keyboard shortcut which turns FilterKeys on is to hold down the **Right Shift** key for eight seconds. This option will not work unless the **Use shortcut** box is selected.

- **ToggleKeys**

  Choosing this function invokes a tone when one of the special locking keys is pressed (Caps Lock, Scroll Lock, Num Lock).
The Sound Properties Tab
At the current time, only one of the two options works: SoundSentry. Using this option generates visual warnings when a system sound occurs. From its Settings window, it is possible to have alerts for windowed programs or full screen text programs (not available in NT).

For Windowed Programs
Flash active window or flash the desktop

For Full Screen Text Programs
Flash display, characters, or border

The ShowSounds feature will display captions for speech and sounds generated by an application which has been designed to work with this feature. Currently this feature is not widely supported.

The Display Properties Tab (not available in NT)
From the front of this panel it is possible to invoke High Contrast color scheme if an application is "smart" about this feature. The Settings window allows the user to choose to invoke the shortcut key, Left Alt-Left Shift-PrintScreen, and to set specialized high contrast color schemes.

It is possible to set everything to white on black or black on white, or specialized color sets. Many color sets come with standard, large and extra-large font choices.

The Mouse Properties Tab

Only one set of functions is controlled by this tab: the ability to use the numeric keypad to move the mouse pointer. It is possible to modify cursor speed as well as to use Ctrl to speed up mouse movement and Shift to slow down mouse movement.

The General Control Panel Tab

• Automatic Reset
From this level it is possible to set a time limit on keyboard inactivity; when that limit is reached, all accessibility functions automatically turn off.

• Notification
It also is possible to ask for warning messages when features turn on (not available in NT), or to set a sound to occur when a feature is turned on and off.
• **SerialKey Devices**
  For students needing to connect serial communication devices to a computer, this access panel allows the user to set which serial port to use and what baud rate to use.

**Notes:**

**Installation**

The Accessibility Options control Panel is part of the default Windows installation. If it is not installed, do so by going to the Windows Setup or Windows NT Setup tab of the Add/Remove Programs Control Panel. Check the box next to Accessibility Options and click OK. If the files are not on the local or network drive, you may have to insert the CD when asked.
Publisher:  
Dragon Systems  
320 Nevada Street  
Newton, MA 02160  
(800) 825-5897  
http://www.dragonsys.com

Retail Cost: $199.00 approx.

System Requirements:
Minimum: 200-MHz Intel® Pentium® processor with M1VD(Tm), or equivalent, IBM® compatible PC, Windows® 95, Windows 98, or Windows NT® 4.0 (with Service Pack 3 or greater).  
Memory Requirements: Minimum: 48 MB RAM for Windows 95 and 98 (64 MB is recommended), 64 MB RAM for Windows NT 4.0.  
Hard Drive Requirements: 200 MB free hard-disk space, CD-ROM drive for installation.  
Audio: Creative Labs® Sound Blaster® 16 or equivalent sound board supporting 16-bit recording.

Description:
Dragon NaturallySpeaking is a speaker dependent, continuous speech recognition system. The active vocabulary size is 160,000 words with a 250,000-word dictionary that allows for accurate word prediction and spelling. Text can be dictated at around one hundred words per minute. The system accommodates multiple voice profiles per computer.

Features include: Select-and-Say(TM) editing and convenient Dictation Playback and Text-to-Speech to speed editing and proofreading and the ability to launch applications and drop-down menu commands by voice. Users can now navigate the Internet by speaking URLs and into fields in Web pages when using Internet Explorer 4.0 & 5.0.

Recommended Uses:
This program is recommended for persons with repetitive strain injury or moderate to severe physical disabilities that impair keyboard usage. Users must be able to produce consistent speech output.

Basic Use:
Each user must individually train Dragon NaturallySpeaking. Training is accomplished through use of the General Training program. Creating a voice profile and completing the training process takes about 45 minutes unless you have a faster than 300 MHz processor which may reduce training time to just a few minutes. NaturallySpeaking works within its own dedicated word
processing environment as well as within many popular applications. When using NaturallySpeaking, the following steps are taken:

1. Load NaturallySpeaking from the Programs menu.

2. Activate the microphone by pressing the numeric keypad + key.

3. Begin speaking clearly and distinctly in short phrases with brief pauses between each phrase.

4. If a phrase or word selected by NaturallySpeaking is incorrect say "Correct" and the word or phrase to be corrected.

5. If the correct phrase or word appears in the suggestion list, say "Choose" and then the number of the desired phrase or word in the selection box.

6. If the desired phrase or word does not appear in the selection box, say "Spell That" and begin spelling the word using the letters of the alphabet. Generally, the correct phrase or word will be identified after the first one or two letters have been spoken. When the desired phrase or word appears, say "Choose" and the number of the phrase or word.

**Intermediate Use:**

Users can insert punctuation marks by saying the name of the mark, (i.e. "period," "comma," "question mark"). A variety of options exist for selecting text. Saying "Select" then word, line, paragraph or document selects a portion of text that can then be edited or formatted in a number of ways. (See attached Quick Reference Guide).

**Reading Text**

Listening to text that has been dictated provides a useful method for identifying recognition errors. NaturallySpeaking provides two methods for listening to dictated text:

To play back digitally recorded speech of your voice dictating text, select the text to be read (i.e. say "select previous paragraph") then say "play that back." Please note that this option only works for text that has not been previously saved and then reloaded.

To play back computer-generated speech of any text in the NaturallySpeaking composition window, select the text to be read (i.e. say "select previous paragraph") then say "read that." This option works for any text file.
Mouse Grid

NaturallySpeaking provides a Mouse Grid navigation system similar to that used in previous and current versions of Dragon Dictate to move the mouse pointer. Saying "MouseGrid" displays a 3x3 grid with nine numbered squares which cover the entire screen. Saying the number of a square "refocuses" the grid to the selected square. Repeating the selection process moves the mouse pointer to the desired object by a process of approximation. Saying "click" selects the object.

Saying "MouseGrid Window" opens the Mouse Grid in the current window. Additional fine-tuning of the mouse pointer can be accomplished by using a limited set of mouse movement commands. Say "mouse (up, down, left or right)" followed by a number between 1 and 10, will move the mouse a few pixels in the selected direction. For example, saying "mouse up 9" will move the mouse pointer up about one-eighth of an inch.

Advanced Use:

Using Internet Explorer by Voice

If you install the NaturalWeb™ Internet Explorer compatibility module you can control Internet Explorer and follow links by voice. Start Dragon NaturallySpeaking before you start Internet Explorer. If Internet Explorer is already running, close it. Start Dragon NaturallySpeaking, then restart Internet Explorer. A NaturalWeb splash screen appears when Internet Explorer starts. When it disappears you can use voice commands to control Internet Explorer, including following links and dictating into editable areas on Web pages, such as boxes on forms.

Following links or clicking buttons by voice

To follow a link or click a button by voice, just say the link or button text or part of the text. You can also say "Click" followed by all or part of the text. You can only follow links that you see on your screen. To follow a link that is low on a page, scroll down until you can see it and then say the link.

A red arrow shows the link or button that is being followed.

If multiple links or buttons match

If more than one link or button matches what you said, an arrow with a question mark appears next to the first one.
1. To click the selected link or button, say "Click That," "That One," or "Click That One."
2. To go to the next match say "Next," "Next Control," or "Next Match."
3. To go to the previous match, say "Previous," "Previous Control" or "Previous Match."

If a link or button does not have text

If you want to follow a link or click a button that does not have text, first say the word or words that best describe the picture. Often, a graphic hotspot has an internal identifier (ALT or NAME) associated with it, and if you say either of these, Dragon NaturallySpeaking will follow the link. If this fails, try the following:

1. Say "Image" to go to the first picture.
2. Say "Next" or "Next Match" until you get to the link you want to follow.
3. Say "Click That" to click the picture.

Notes:

• You cannot follow links on image maps (pictures with multiple links), or on active elements such as Java applets by voice.
• If an image link has an ALT identifier, the Browser may show you the ALT text when you hold the mouse over the image for a short time. You can then say the text you see to follow the link.
• The arrow indicator does not appear in secure documents.

Vocabulary Builder

In order to improve recognition accuracy, NaturallySpeaking provides a Vocabulary Builder option that extracts, analyzes and stores specialized vocabulary drawn from documents you’ve submitted for review.

To use this option, select Vocabulary Builder from the Tools menu and follow the onscreen directions.

Notes:

Network:

It is not recommended to run Dragon Naturally Speaking from a server. Even moving voice files from one computer to another requires a special sequence of steps. A networkable version has been announced and will be released some time in the year 2000.
Installation:

For NT installations, always login as Administrator for that computer. Insert the CD into the drive and wait for the install program to start. If your PC does not have autorun enabled, you will have to run setup either from the run command or by browsing in the Explorer. Follow the onscreen directions to install the program.

Most problems with Dragon NaturallySpeaking stem from a poor signal to noise ratio. This may be caused by any of the following: incompatible sound card, a bad microphone, microphone not matched to sound card which may need a booster pack installed, poor voice quality such as not loud enough or inconsistent speech production. High quality microphones are recommended to compensate for these problems.
Duxbury Braille Translator ver. 10;2e (Win)

Publisher: Duxbury Systems
270 Littleton Road Unit 6
Westford, MA 01886-3523
978-692-3000
http://www.duxburysystems.com/

Retail Cost: $595.00
(upgrade pricing available)

System Requirements:
A Pentium machine running Windows 3.1 or Windows 95, or 98 and NT and Macintosh. A braille embosser is required if braille materials are to be produced.

Description:
This software translates text to grade 2 Braille and exports it to a Braille embosser. Grade 2 braille has the same alphabet as Grade 1, but it has added contractions for many words and word segments. The software can also be configured to export a braille file to a printer if a print copy is desired.

Recommended Uses:
DBT is simple to use and yet its broad range of capabilities and its accuracy have made it a program widely used by most major braille production centers. This program installs a font in the Windows system. This font can then be used by other programs: e.g., for text labels in a graphics program used to create maps or diagrams for blind students (such material can then be "toasted" by a graphics image enhancer to produce tactile images).

Basic Use:
The file formats most efficiently supported by Duxbury are ASCII, SGML/ICADD, and WordPerfect versions 5.0, 5.1, 5.1+, 5.2, 6.0, and 6.1 and Microsoft Word 95, 97.

Important: This version does not yet recognize Office 2000 documents; therefore it is necessary to save a Word 2000 document as a Word 6 document. This older file format imports nicely into Duxbury.

Once a file is opened in Duxbury, it is possible to see it as text or as braille. It also is possible to create a text file in Duxbury and then convert it to braille. It also is possible to import a file created in braille. Duxbury supports a six-key editor for those familiar with six-key input.
Duxbury is "smart" about formatting, and in most cases, there is no need to take advantage of the many formatting options which Duxbury does provide. While viewing text of an imported file, it may be necessary to remove minor extraneous characters before converting the file to braille.

**Basic Steps to Import a File into Duxbury**

1. Have ready a saved Microsoft Word document, (e.g., created in Office 97). Make sure the Braille embosser is turned on.
2. Start the Duxbury program.
3. From the Duxbury file menu, select *Open*.
4. From the *Import File* window, make sure *Standard* file format is selected in the top window, and *Microsoft Word 7 or 97* is selected as the filter in the lower window. Click *OK*.
5. The file text appears on screen.
6. From the *File* menu, select **Translate**. The file changes to braille form.
7. From the *File* menu, select **Emboss**, and the material is sent to the braille embosser.
8. (Or, at this point it is possible to select **Print** if the braille material is to be sent to a standard printer for a print copy of the braille.)

**The Production of Graphic Images**

With the recent introduction of graphic image enhancers (one from Reprotronics or p.i.a.f. [Pictures in a Flash] from HumanWare) there are numerous kinds of tactile materials which can be created for braille users:

- Charts
- Diagrams
- Maps
- Other Innovative. Study Aids

**Important:** The fact that Duxbury installs a braille font into the Windows system allows other computer applications to use a Braille font, e.g., for labeling graphical diagrams.

A chart or graph or a small braille file can be printed on regular paper and then Xeroxed onto heat-sensitive paper that will "puff" in the p.i.a.f. or other graphics enhancer.

**Braille and Print**

If **Interline Print** is selected in the **Print** window, Duxbury also can print a text copy of each line under each Braille line so that it is possible to get a printout of both text and Braille, or if sent to a Braille embosser which also supports printing, Braille and print can be produced simultaneously.
Notes:

Pricing for other platform versions of Duxbury:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBT DOS</td>
<td>$550</td>
</tr>
<tr>
<td>DBT Win</td>
<td>$595</td>
</tr>
<tr>
<td>DBT Mac</td>
<td>$645</td>
</tr>
<tr>
<td>DBT Dual (DOS &amp; Win)</td>
<td>$750</td>
</tr>
</tbody>
</table>
JAWS 3.5.37 for Windows (95/98/NT/2000)

Publisher:  
Henter-Joyce, Inc.  
11800 31st Court North  
St. Petersburg, FL 33716-1805  
(800) 336-5658  
http://www.hj.com  
(See Notes section for more Purchase Information and Software Maintenance Agreement information)

Retail Cost: $ 795/1495

System Requirements:

To use JAWS for Windows, version 3.5, you need:

- A personal computer that will run the Microsoft Windows® 95 operating system or later, or the Microsoft Windows NT® Workstation 4.0 or later.
- If Eloquence, the free software synthesizer for JFW software will be used, a Windows 95 or Windows NT compatible sound card is necessary. If Eloquence is not used, a JFW compatible hardware synthesizer such as the DECTalk Express is required.
- 30MB of available hard disk space required.
- VGA or higher-resolution video adapter (Super VGA 256-color recommended).

As with most systems, the faster the processor and the more memory your computer has the better the performance of your computer and our product.

JFW 3.5 for Windows is a true 32-bit program, and will not work in the Windows 3.1x environment. For the convenience of those who need speech access in the Windows 3.1x environment, JFW 2.0 is also included on the installation CD.

JAWS supports Microsoft Word under Microsoft Windows 95, 98 and Microsoft Windows NT. When using Microsoft Windows NT, Service Pack 4 or later is required. For system requirements for Microsoft Word, refer to the Microsoft Word documentation. For most complete Web access, MS Internet Explorer (IE) 4.01 or 5.0 must be used. Version 4.01 of IE is on the JFW 3.2 distribution CD.

Description:

JAWS for Windows is a screen reader that uses the numeric keypad for its basic reading functions. A number of interactive hot key commands are available to change settings easily; these generally are prefixed by the Insert key and then a letter, number or function key from the alpha side of the keyboard.
There are two particularly strong features in JAWS which help the user: Verbosity Level and Help.

1. There are three levels of verbal assistance provided to the user: a lot (beginner), some (intermediate) and little (advanced). The default full verbosity level is very informative for the new user.
2. The extensive help functions in JAWS for Windows are well developed. The on-line help for JAWS is rich, and there is included an additional level of help: context-sensitive help.

Extensive information about the Windows environment is included with the JAWS documentation. A developed scripting language also comes with JAWS so that advanced users may configure JAWS for unique applications or customize an existing application configuration.

What's New in JAWS 3.5.36 (Win 95/98/NT/2000)

Network Support

JFW can now be network enabled. For those with multi-user licenses, a single network enabled copy of JFW can now be installed on a server computer and be run from multiple computers by a variety of users. This means that any user can go to any computer on the network, activate and use JFW with his or her personal preferences preserved.

Note: Network enabling requires a network authorization key.

Windows 2000 Professional Support

New functions have been added to the JFW 3.5 Patch to fully support Windows 2000. This is the primary reason for this patch since Windows 2000 came out after our initial release of version 3.5. JAWS now works properly in all major areas of Windows functionality including the use of built in applications such as Internet Explorer 5.0, Windows Explorer, Control Panel.

One of the changes that Microsoft made in Windows 2000 is in the "Standard Windows" appearance-setting scheme. When tested it was discovered that with the new settings JFW would not correctly read icons and graphics labels. However, it is possible to correct this by changing back to the original settings, which are now found in the "Windows Classic" scheme. See the note below for details on how to change this setting.

Note: When JFW is installed in Windows 2000, in order to have graphics labels read properly, the Windows Settings must be changed. Microsoft has
changed the parameters of "Standard" desktop settings and this must be reset to the "Classic" setup. Select My Computer from the desktop, go to the Control Panel Icon and press Enter. From the Control Panel, move to Display, press Enter to open, and then Ctrl Tab to the Appearance tab. Select "Windows Classic" in the Scheme dialog.

The Run JAWS First feature is now available for Windows NT with service pack 4 as well as in Windows 2000 Professional. This feature is still available in Windows 95 and 98.

**Virtual PC Cursor**
The Virtual PC cursor was introduced in JAWS for Windows version 3.31. The intended functionality is to mimic the PC cursor in its ability to navigate and view HTML documents using the same keystrokes and commands used while working in a word processing program.

Since there is no cursor or insertion point in an HTML document such as a Web page or HTML Help window, JAWS for Windows allows visually impaired computer users to navigate HTML documents as though there is a cursor or insertion point. This means that editing commands such as selecting, copying, and pasting text are also available when using the Virtual PC cursor.

The Virtual PC cursor is activated automatically whenever the application focus is brought into an HTML document such as a Web page or HTML Help window. Many e-mail programs support the ability to create HTML e-mail messages and view messages sent in HTML format as well.

**Skip Repeated Text on New Web Pages**
Many Web sites contain common text on all of their pages. When this option is checked, JAWS positions the Virtual PC cursor on the new text of the newly loaded Web page.

**Screen Track Virtual Cursor**
When this option is checked, the screen will track the Virtual PC cursor. This is necessary if MAGic is being used, or if a sighted user needs to follow along visually. The default is ON.
**Say Link Type**
There are numerous types of links. When this option is checked, JAWS announces the link type during Say All and when navigating with the Virtual PC cursor.

**Identify "Same Page" Links**
Links can point to other places on the currently loaded page. When this option is checked, JAWS will announce such links as "Same Page links."

**Lines Per Page**
This option determines how many lines constitute a page when the Virtual PC cursor is active. The default value is 24.

**Maximum Line Length**
This option determines how many characters constitute a line when the Virtual PC cursor is active. The default value is 150.

**Text Block Length**
The Move To Next Non-Link Text script uses this option. JAWS will move to the next block of contiguous characters that are at least the number of the value set here. The default value is 25. This is how JAWS searches for body text to read.

**Graphic Verbosity**
This option determines the verbosity in which JAWS speaks non-linked graphics on Web pages. The choices are No Graphics, Tagged Graphics, and All Graphics. The default setting is Tagged Graphics.

**Graphic Link Verbosity**
This option determines the verbosity in which JAWS speaks linked graphics on Web pages. The choices are: No Graphic Links, Tagged Graphic Links, and All Graphic Links. The default setting is All Graphic Links.

**Image Map Link Verbosity**
This option determines the verbosity in which JAWS speaks image map links on Web pages. The choices are: No Image Map Links, Tagged Image Map Links, and All Image Map Links. The default setting is All Image Map Links.

**New Frame Indication**
This option determines the way in which JAWS indicates the user has moved from one frame to another on Web pages. The choices are No Indication, Say Frame Name at Beginning and End, and Say New Frame When Entering. The default setting is Say Frame Name at Beginning and End.
**JAWS Cursor Restriction Feature**

The JAWS cursor (or Invisible Cursor) now has 3 separate levels related to where it can move on the computer screen. In previous versions of JAWS the movement of this cursor was restricted to either the current or parent window with focus when navigational keys were used.

Now, in addition to the previous restriction options, the JAWS cursor can also be set to move freely throughout the entire screen area. Each time **Insert R** is pressed when the JAWS cursor on, the next level of restriction is spoken and moves the status to that level.

**Application Window Restriction**

When the JAWS or Invisible Cursor are within the Parent Window with focus, the cursor will not move outside the Parent window when using standard navigation keys such as **Page Up Page Down, Home, End**, or Arrow keys. This is the default selection.

**Current Window Restriction**

When put in this mode, the JAWS or Invisible Cursor are restricted to the current window that they are in at that moment. This is useful to restrict movement and reading to a control such as a list box without having to hear other information outside of that specific control. The cursor will not move outside the Window with standard navigation keys such as **Page Up, Page Down, Home, End, or Arrow Keys**.

**Unrestricted**

In this new Unrestricted Mode, with the JAWS or invisible cursor active, the user can freely roam the entire screen regardless of the number of Windows open or how they appear on the screen. Using this mode, the user can easily browse the screen line by line and get an understanding of everything available on the screen.

**Tables Navigation Support for Many Applications**

There are new navigation keys to be used when in a table. These commands read the contents of the cell, along with the associated row and column headings. The same keystrokes can be used to navigate tables in Microsoft Access databases, Excel, Internet Explorer 5, PowerPoint, and Word, and in Corel QuattroPro and WordPerfect.

Use the following navigational keys when working inside a table, spreadsheet or database:
Say Cell use Alt Ctrl Num Pad 5. Reads the row and column coordinates, followed by the cell contents and then the appropriate row and column headings.

Note: Because of this new function for Alt Ctrl Num Pad 5, the read current paragraph command has be changed to Ctrl Num Pad 5 is now used to read the current paragraph.

Next Cell use Alt Ctrl Right Arrow. Moves the focus to the next cell in the same row and then announces the column heading followed by cell contents and then the column number.

Prior Cell use ALT CTRL LEFT ARROW. Moves the focus to the previous cell in the same row and then announces the column heading followed by cell contents and then the column number.

Down Cell use Alt Ctrl Down Arrow. Moves the focus to the cell below the current cell and reads the row heading followed by cell contents and then the row number.

Up Cell use Alt Ctrl Up Arrow. Moves the focus to the cell above the current cell and then announces the row heading followed by cell contents and then the row number.

Note: For all of these tables keystrokes: in a verbosity setting higher than beginner the new row number will not be heard.

Note: If there is no cell available in the direction the user is trying to move, JAWS will state that the bottom or top of column or the end or beginning of a row has been reached.

First Cell In Table use Alt Ctrl Home. Moves to first cell in current table and reads row and column coordinates followed by contents of the cell.

Last Cell In Table use Alt Ctrl End. Moves to the last cell in current table and reads row and coordinates followed by contents of the cell.

Internet Explorer 5.0 Support

Screen follows the Virtual PC Cursor
The screen will now scroll to track the location of the Virtual PC cursor.

Persistence of Settings in List of Links
If the user filters or organizes their list in the Link List dialog, this setting will remain until they change it or exit JFW. The default setting that ships with JFW is All Links in Tab Order.
**Improvements to Links List**
The Links List Dialog status line has been changed. The status line no longer contains the display filter or the sort order, as these are easily accessible by tabbing around the dialog. The status line now contains the URL for selected link. This enables the user to determine which of several links with the same text name they want to activate or move to, i.e., which "Click Here" is the right one to select.

**Graphic Announcement Toggle**
The user now has the ability to turn off the announcement of graphics that are not links. The user is able to toggle this through the HTML Settings Dialog in the Configuration Manager. The choices are: No Graphics, Tagged Graphics, and All Graphics. The default setting is All Graphics.

**ALT Text and Screen Text Toggle**
Often, the ALT Text of links on a Web page is different from the text shown on the screen. Depending on the Web page, either can be more descriptive. The user now has the choice to select which of these they would like JFW to seek as the primary text to speak.

If the user selects Screen Text, JFW will use the screen text if it exists, otherwise, it will use the ALT Text. If neither exists it will use the URL.

If the user selects ALT Text, JFW will always use the ALT Text, if available, otherwise, it will revert to the screen text. If neither exists it will use the URL.

The user is able to toggle this temporarily through the Verbosity dialog, or permanently through the HTML Settings dialog in the Configuration Manager.

**Word 2000 Support**
There are several new Word tools supported in JFW 3.5. These include Track Changes and Real Time Spell Check.

**Tracking Changes to Documents**
The Track Changes feature can now be used to announce the revision type and author when the cursor moves into modified text. It also lets the user know when the cursor has moved out of modified text; it also is possible to bring up an entire list of revisions from which to select.

**Check Spelling and Grammar As You Type**
JAWS now announces a misspelled word or grammatical error as the user is typing. It also is possible to bring up a list of spelling or grammar errors in the document and scroll up or down the list to select and move directly to the one desired.

**Form Fields**
JAWS now detects form fields such as text boxes, drop-down menus and check boxes. JFW will automatically detect the form field prompt if it is to the left or above but if using the JAWS cursor to locate it, it can be anywhere.

**Tables**
In addition to the new keystrokes to help navigate in tables and spreadsheets, there is also the added ability for JFW to detect tables and their row and column titles.

**More Verbosity Dialog Support**
There are several other options that are now supported by JFW. These options are selected using the Verbosity dialog. Included are the following:

- Detect Style Changes
- Borders and Pictures Detection
- Reading WordArt text tag
- Reading Bullets in a list entry
- JAWS and Invisible Cursor Context Detection

**Screen Sensitive Help Enhancements**
Screen Sensitive Help has been adjusted and enhanced to tell the user about:
- Header/footer pane
- The footnote/endnote pane
- The comments pane
- The document summary
- Number of sections and information about the current section
- The number of objects in the drawing
- Current table cell width and height in points.

**Insertion Point Information Announcement**
The *Insert F* command has been modified. When pressed once it gives font, style, paragraph and outline information for the character to the right of the insertion point or for the selected text. When pressed twice, it gives font and style information for the insertion pointer, i.e., what the format of new characters typed would be.

**Say Line and Column**
Say Line and Column now gets the information from the Object model rather than the status line so it will work even with no status line visible.

**Say Window Prompt And Text**

Spelling errors, grammatical errors, fields, form fields, borders, etc. are now included in addition to the cell content and coordinates when using Insert Tab. When announcing bordered regions, this keystroke will only announce the border and text of the immediate region, unlike the Border keystroke, which will describe each bordered region, starting from the current one and working outward.

**Working in Outline View**

Commands are now available to support the promoting and demoting of a heading to different style levels in Outline View. JFW announces the new level in the PC cursor mode.

**Other Word Enhancements**

JFW users can now use several Word advanced features such as Mail Merge and Proofreading.

Some Toolbar items are now available, including; Data Source Form, Insert Table, Insert Column, and Insert Microsoft Excel Spreadsheet.

Improved functions in tables include Say Line in table cells when markers or other symbols are displayed on the screen and Braille will now track in Tables using Alt Control Arrow keys.

In Beginner Verbosity JFW will automatically select an item in List Views when using Backspace or Enter.

More effective searches in document text are now achieved with JFW using Find Next, because JFW will now read the next occurrence in context.

Find Back and Forward in the Accept or Reject Changes dialog now reads the next revision and the sentence containing the revision. JFW will also read the selected revision and context.

The Spellchecker in Word speaks the next error using added JAWS functionality.

**Excel**
In addition to the new table navigation keystrokes, several other features have been added to JFW to support Excel.

In addition to the default Read Selected Range, which reads cell coordinates and all selected cells, a new verbosity setting has been added to version 3.5.36 to allow users to "Read First and Last Cell in Selection Only."

JFW keystroke **Insert F** now identifies four kinds of underline styles instead of just stating if underlining is on or off.

**Insert Num Row** 5 and **Insert F** (when the color has been changed from the default) will now correctly identify the cell’s text color as selected in the Font Color menu.

Using **Ctrl Left** and **Ctrl Right Arrows** while editing a cell (i.e., after pressing **F2**) will now correctly read the prior and next word in the cell. JFW now automatically selects a file listed in the Open or Save As listviews when JFW is set at Beginner Verbosity.

Screen Sensitive Help in the worksheet has been enhanced to announce the number of worksheets in the current workbook. **Ctrl Page Up** or **Down** and **Ctrl Shift S** can be used to move between other sheets.

**PowerPoint 2000 Support**

With the Internet and the Microsoft PowerPoint 2000 presentation graphics program, it is possible to develop and deliver presentations for the Web as well as for meetings. In PowerPoint 2000, many familiar features have been enhanced to make presentation development and delivery, online or otherwise, easier.

The main PowerPoint screen, which is called the "Normal View," is divided into three panes, each pane serving a different function. This lets the user switch between a variety of tasks quickly and easily. The first pane is called "Slide View" and shows the current slide. The next pane, called "Notes Page View," provides space for the user to add any personal notes that refer to the slide currently being shown. The last pane, called "Outline View", shows the text that appears in the current slide. As text is added directly into the slide, it automatically appears in the outline view. Alternatively, any changes made to the text in the outline view are automatically reflected in the slide view. Pressing the function key **F6** toggles through these panes.

JFW now easily reads OLE charts and objects Excel and other spreadsheets, or .BMP files from the Paint program. Bring any of these objects into focus.
from the top level by tabbing to them and pressing **Enter**. Go back to the top level by pressing **Esc**, at which point it is possible to tab to other objects on the slide.

New functionality has been added that helps the user determine the amount of text that can easily fit into a particular slide in PowerPoint. JFW does this by alerting the user that there has been too much text put into a placeholder. This feature is called Text Overflow Detection. Screen Sensitive Help will also provide the information when **Insert F1** is pressed. JFW can also announce the approximate number of lines that are left based on the font size that was used in the last line typed. This detection is on by default and will help prevent too much information being put on one slide, which results in the slide looking cluttered.

There is also an Object Overlap Detection feature that has been added as another Verbosity item. This detects when objects on the slide overlap and is also on by default.

JFW will now speak the Slides from Files and Custom Animations dialogs in both PowerPoint 97 and 2000.

In PowerPoint 2000, users can now use cut and paste keystrokes to rearrange slides in the Slide Sorter View.

A new keystroke has been added which enables the user to read the speaker's notes in normal or Slide Show views: **Ctrl Shift N**.

JFW now automatically selects a file listed in the Open or Save As listviews when JFW is set at Beginner Verbosity.

The keystroke **Control Shift F** is no longer used to toggle Format and Text announcements. Instead, the user should select the Verbosity dialog using **Insert V** and select Format and Text Announcement to On.

**Microsoft Access**

Subforms and main forms are now identified when Tab or **Ctrl Tab** is used to navigate them.

When typing text, which is auto-completed, such as when entering text in a lookup field or macro entry, JFW will now automatically read the completed text.
When adding controls to a form or report with the Select Toolbox Control command, a label control is now automatically created along with the selected control.

When listing form controls, JFW now shows the disabled and visible status. When doing a Backspace or Enter in the Open or Save As listviews in these dialogs, if a folder or file is not selected, at beginner verbosity, JFW will automatically select an item.

**JFW 3.5 Support of the MAGic Keyboard**

New functionality has been added to allow both MAGic 6.2 and JFW 3.5 to work together. This is especially helpful for users who use both MAGic and JFW together for the majority of their computer work.

During installation of MAGic, users are given the option to add the MAGic Keyboard Layout to JAWS. Then to run the two programs together, MAGic users simply select to use the JFW 3.5 tracking engine using the Tracking Engine option on the Preference menu. The next time MAGic is run, JFW automatically begins speaking. Along with this, the user can select the MAGic Keyboard Layout in place of the JFW Default or Laptop Keyboard Layout. This setting is found in the JAWS File Menu under Keyboard.

When using the MAGic Keyboard Layout, when a JFW keystroke is used that has an equivalent in MAGic, the MAGic keystroke takes precedence. For example, in JFW the keystroke Ctrl Shift C is used by JAWS when in several popular applications; in Access it is used to create a relationship and in PowerPoint it is used to read a table, column by column. When the MAGic user presses Ctrl Shift C it "Centers the Mouse in View," or more simply, moves the mouse pointer to the middle of the active view so that the magnification user can more easily find it.

**Changes in the JFW User Interface •**

In the File Menu, Run JAWS From System Tray. This feature removes JAWS from the list of items on the taskbar, which saves time when Alt Tab is used to move through the list of active programs. JAWS can still be accessed quickly using Insert J.

**File, Keyboard Addition**

If a custom keyboard layout has been created, it will appear along with the traditional laptop and desktop layouts in the File Menu, Keyboard submenu.

**Voices Menu**
The tab order in the Voice dialogs has been changed to place the Voice pitch after the selection of the Voice Person.

**Help Menu**

Quick Reference has been changed to Keyboard Commands to include the keyboard commands that appear on the quick reference cards shipped with JFW, as well as a comprehensive listing of all the default keystrokes that ship with JFW as well as many basic Windows keystrokes.

**New Configuration Manager Settings**

**Set Options, Text Processing**

**Reading Dates**
There are new options in the Configuration Manager that allow the user to select how the date will be spoken. It is now possible to have the option of having numeric dates spoken.

**Reading Dollars**
There are new options in the Configuration Manager under Text Processing that allow the user to select how numbers preceded by a dollar sign are spoken. Check Speak Dollars to have numbers with the dollar sign in front of them expressed in dollars and cents. For example: $45.22 would be spoken as, "45 dollars and 22 cents."

**Java Accessibility Bridge**

Support For Java Applets And Java Applications Supported by Sun Microsystems SWING Classes (Via The Java Access Bridge)

JFW 3.5 provides access to programs supported by the Sun Microsystems Java Accessibility Bridge. This requires the user to install the Bridge as well as Sun's Java Virtual Machine. This version of JFW will work with the jdk1.1.8 virtual machine, the Java Runtime Environment distributed with jdk1.1.8, the jdk1.2.2 (Java2) Virtual Machine, the Java Runtime Environment distributed with jdk1.2.2, and the Java Web browser plug-ins for jdk1.1.8 and jdk1.2.2. No other Java VM is automatically supported in this version of JFW.

When in a Java application, press **Ctrl Insert V** twice quickly to hear the Java VM and AccessBridge version information.
JavaScript, a commonly used extension to HTML, is in no way (other than in name) related to the Java programming language. JavaScript is used by Web
developers to dynamically change the HTML displayed on a Web page. Wherever possible, JFW reads the changes made by JavaScript to the user. Many older Java applets and stand-alone applications, probably representing the majority of those currently available, were written with the AWT classes. JFW 3.5 does not automatically support these programs. Programs written with classes, the new standard from Sun Microsystems, work the Swing seamlessly with the Accessibility Bridge and are expected to constitute the majority of new Java development.

As of this writing, there are over two hundred programs available that are written with the Swing classes, which automatically speak with JFW 3.5.

**Basic Commands:**

**Working with Context Sensitive Help**
JAWS has a powerful on-demand Help feature that provides **verbal information and/or instructions for a current task**. At any time:

- use **Insert Fl** to hear screen sensitive help—useful for learning windows.
- use **Insert F1,F1** to bring up application-specific help window in major applications: e.g., Word.
- use **Insert H** to hear JFW hot key commands and/or context-sensitive, application-specific help.
- use **Insert W** to hear Windows keyboard commands.

**Working with Keyboard Help Mode**
JAWS supports a user-exploration mode. This function, called the Keyboard Help Mode, is toggled on by **Insert-One** (from the number row on the alpha portion of the keyboard). When this function is turned on, all letter keys echo their identity, and all command sets, e.g., **Insert V**, do not actually perform a function, but instead are identified and their function described. This mode is toggled off by entering **Insert-One**.

**About the JAWS Interface**
JAWS uses the numeric keypad as its keyboard base for special reading commands. JAWS now supports three main cursors:

1. **PC Cursor**
2. **JAWS Cursor**
3. **Virtual Cursor**

The PC cursor is directly linked to system and application operations as well. as basic keyboard operations. To activate the PC cursor, press **Numpad**
**Plus.** To activate the JAWS cursor, press **Numpad Minus.** Only one can be active at any one time.

The JAWS cursor is directly linked to the Microsoft Windows mouse pointer. Like the mouse pointer, it is possible to move around windows with the JAWS cursor while the PC cursor remains at its current location. Likewise, the JAWS cursor stays stationary when the PC cursor moves and remains in a fixed location until activated. As in the case of the mouse pointer the JAWS cursor is not affected when you type.

It is possible to toggle between the two cursors, and it is also possible to route one cursor to the other cursor. **Insert Minus** routes JAWS to the PC cursor. **Insert Plus** routes the PC cursor to the JAWS cursor.

The virtual cursor is not visible on the screen but it has been designed to perform smart automatic reading of areas. Unless turned off, this cursor is automatically on when working in Internet Explorer. Because of this new virtual cursor, JAWS is now able to accurately read columnar text on web pages, and can also discriminate between unrelated text like links and body text.

Interactive reading is also possible by using the standard arrow keys. There are two types of commands in JAWS: the majority are reading commands issued from the numeric keypad, but there also are interactive settings commands issued from the alpha keyboard.

**How JAWS Settings are Managed**

Basic screen reader settings such as voice pitch and rate, type of keyboard announcement, etc., are accessible through a menu bar in the JAWS Settings Window. Use **Insert J** to bring up the JAWS application window. (Although many functions available through the menus can be configured by hot key commands.). There are five menu options:

1. **File** (use to have JAWS start first, to change from full to laptop keyboard, or to exit the JAWS program)
2. **Voices** (use to change speech rate)
3. Utilities (to access program managers, e.g., Configuration Manager Keyboard Manager, Dictionary Manager, Script Manager—for advanced use)
4. **Language** (use to change languages, if installed, or to change synthesizers, or select "no speech")
5. **Help** (This is an excellent source of information about JAWS: keyboard commands; specialized help for major applications; a "What’s New"
section especially useful when installing and using an upgrade to current version.1)

**Refreshing the Screen**
Sometimes JAWS does not seem to read properly, and when this is suspected, refreshing the screen display with the JAWS command **Insert Escape** will usually restore normal reading function.

**How to Open a Menu**
1. Tap the Alt key and then tap the first letter of the menu option. Once the Alt key has been tapped, it is possible to arrow across through the main menu options.
2. Move down in the menu with the **Down** arrow key.
3. Tap the **Enter** key after hearing the desired topic announced to open its settings box.

**Interactive Hot keys from the Alpha Number Row**

**Insert-1** Toggles the keyboard help on or off.

**Insert-2** Toggles through the keyboard echo function: characters, words, or none.

**Insert-3** Use this before entering an application command that is identical to a JAWS command; JAWS will ignore the command.

**Insert-4** Toggles to standard or active graphics mode. Use active graphics mode if JAWS does not read all tool bar buttons.

**Insert-5** Reads color of text at cursor.

**Insert-6** Hot key to bring up the Configuration Manager.

**Insert-7** An advanced command to work with types of window classes.

Insert-8 Brings up Keyboard Manager, an advanced component. The Keyboard Manager allows you to create application specific key map files.

**Insert-9** Brings up Frame Manager, an advanced component.

Insert-Zero Brings up JAWS Script Manager, an advanced component.

**Interactive Hot Keys from the Alpha Keyboard**
**Insert B** Read all of dialog box in Tab order. This allows the user to understand what is in a dialog box before attempting to Tab through its topic area.

**Insert C** In some applications will read word in context (e.g., spell check).

**Insert D** Brings up Dictionary Manager.

**Insert F** Identify font name, size and attribute of text at active cursor.

**Control Insert F** Brings up JAWS Find dialog.

**Insert II** Context-sensitive hot key application-specific help is verbalized.

**Insert E** In a dialog box or special window, announces what button will be selected if Enter is tapped.

**Insert J** Bring JAWS window forward. If JAWS is minimized, this will maximize the window; if JAWS is open but covered, this will bring the window forward.

**Insert R** Restrict action of JAWS cursor. If this is turned on, JAWS will read only in the active child window. When restriction is toggled off, JAWS cursor can read anywhere on screen display.

**Insert S** Toggle through screen echo settings.

**Insert T** Read title bar of window.

**Insert V** Brings up Adjust JAWS Verbosity list box. Tapping the Space Bar toggles through verbosity levels of selected item in list box. Specific verbosity levels may be set for user verbosity preference, style change detection, context detection, screen echo, typing echo, say all by, punctuation level, format and attribute changes speak, graphics verbosity, ANSI character verbosity, braille verbosity, and mute synthesizer.

**Insert W.** Speaks general Windows help.

**Insert X** Say frame at cursor; says the text in the frame that the cursor is in.

**Insert F4** Unload JAWS.
**Insert F6** Minimize all applications on the desktop.

**Speech Pad Minus** Turn on JAWS Cursor.

**Speech Pad Plus** Turn on PC Cursor. The PC cursor tracks the insertion point or the highlighted selection cursor.

**Insert Up Arrow** Read Current Line.

**Up Arrow** Read Prior Line.

**Down Arrow** Read Next Line.

**Left Arrow** Read Prior Character.

- **JAWS Cursor** Speak Prior Character.
- **PC Cursor** Select prior icon, select prior menu item, or move insertion point to the prior character.

**Right Arrow** Read Next Character.

- **JAWS Cursor** Speak next character.
- **PC Cursor** Select next icon, select next menu item, or move insertion point to the next character.

**Speech Pad 5** Read Current Character.

**Insert Left Arrow** Read Prior Word.

**Insert Right Arrow** Read Next word:

**Insert Speech Pad 5** Read Current Word.

**Insert Speech Pad 5** (pressed twice within a half second) Spell Current Word.

**Page Up** Move Up One Screen or to Top of Window.

- **JAWS Cursor** Move to top of active application or child window depending on the setting for JAWS cursor restriction.
**PC Cursor** Move insertion point up one screen.

**Page Down** Move Down One Screen or to Bottom of Window.

**JAWS Cursor** Move to bottom of active application or child window depending on the setting for JAWS cursor restriction.

**PC Cursor** Move insertion point down one screen.

**End** Move to the End.

**JAWS Cursor** Move to the end of text on the current line or to the last graphics on current line.

**PC Cursor** Performs the End function for the application. For example, it could move the insertion point to the end of text on the current line or to the last item in a list box.

**Home** Move to the Beginning.

**JAWS Cursor** Move to the beginning of text on the line or to the first graphics on the line.

**PC Cursor** Performs the Home function for the application. For example, it could move the insertion point to the beginning of text on the current line or to the first item in a list box.

**Insert Home** Speak From the Left Edge of the Window to the Cursor.

**Insert Page Up** Speak From the Cursor to the Right Edge of the Window.

**Insert End** Read Top Line of Window.

**Insert Page Down** Read Bottom Line of Window.

**Insert Delete** Speak the Coordinates of the Active Cursor.

**Insert Minus** Route (move) the JAWS Cursor to the Location of the PC Cursor.

**Insert Plus** Route (move) the PC Cursor to the Location of the JAWS Cursor. This moves the insertion point or selection cursor to the location of the JAWS cursor and is equivalent to a single click of the left mouse button.
**Insert Escape** Refresh Screen.

**Delete** Delete character at cursor; does not announce character deleted; instead announces the new character at the cursor.

**Alt Delete** Announce active cursor position (in pixels).

**Insert Delete** Announce PC cursor position in row and column position.

**Alt Insert** Toggle between insert and overwrite editing modes.

**Alt Down Arrow** Read dialog prompt.

**Insert 3** (from alpha) Pass next command through to application.

**Plus** Invoke PC cursor.

**Minus** Invoke JAWS cursor.

**Minus** (tapped twice) Invoke invisible cursor from either PC or JAWS Cursor.

**Additional Interactive Commands**

**Insert Fl1** Say Taskbar.

**Insert F12** Say System Tray.

**Control Shift H** Say hotkey for current control focus.

**Insert Control Down Arrow** Say Help window.

**Insert Shift Down Arrow** Say selected text.

**Insert Tab** Say window prompt and text.

**Insert E** Say default button of dialog box.

**Intermediate Use:**

How to Hear All Dialog Options in Settings Box
1. Hold down the **Insert** key and tap the b key. JAWS will announce the entire contents of the box in the order that the Tab key will take. Current settings are not announced.

**How to Navigate with Tab Key through a Dialog Box**

1. Tap the Tab key to navigate forward through options.

2. **Shift Tab** will navigate backward through options.

3. JAWS will announce each topic box and its current setting.

4. Use the **Arrow keys to move up and down within the topic** box to hear other possible settings. Each setting is automatically selected as it is read and automatically de-selected if the arrow is moved off the selection.

5. Once the right setting for the topic is selected, resume with the Tab key to move to the next topic box.

6. **If a scroll bar** is announced in a dialog box, the **Right** and Left arrows will move the **scroll bar** selector point. For example, a scrollbar is used to set speech rates and volume.

7. A **check box** can be selected or de-selected by tapping the **Spacebar**.

8. Use of **Insert Fl** may bring up additional information about a dialog box element.

**Selecting Text**

Use standard Microsoft Word keystrokes to select text:

- Shift Right Arrow select character
- Control Shift Right Arrow select word
- Shift End select line
- Shift Down Arrow select next line

**Example:**

1. Type one or two sentences so that text appears on two lines.
2. Make sure the PC cursor is active by tapping the **Insert Del** key to check status.
3. Move the cursor to the beginning of the first line of text.
4. Hold down the **Shift** key and tap the **End** key to select text to end of line. The text will be read.
5. Still holding down the **Shift** key, tap the **Down** arrow key to select the next line of text. The text will be read.
6. Text can be de-selected by tapping the **Slash(/)** key on the numeric keypad.
7. To re-read selected text: Insert Shift Down Arrow

**Copying Selected Text to Another Position in a Document.**

1. Enter **Control C** to copy selected text to the clipboard.
2. Move the cursor to another position in the open document.
3. Enter **Control V** to place the copied text.
Deleting Selected Text
Once text has been selected, enter Control X.

Moving Selected Text to Another Position in a Document
When text has been cut, move cursor to new position in document and enter Control V.

Formatting Text once it has been selected
The following keyboard shortcuts will format selected text:
Control B Bold
Control U Underline
Control Shift Z Remove formatting and return text to normal

Advanced Use:
How to use the JAWS cursor like a Mouse Pointer
The JAWS cursor can be used like a mouse pointer with the mouse keys that are described below. To move the Mouse Pointer, use speech pad keys:

Slash (/) Single Left Mouse Click on speech pad. This selects the item at the JAWS cursor.

Slash (/) Twice in a second, Double Left Mouse Click. This chooses the item at the JAWS cursor.

Insert Slash (/) Drag an Object on the Desktop. Use the JAWS cursor to point to the object, press Insert and then Slash (/) to lock the mouse pointer on the object, then use arrow keys to drag it. Press Insert Slash (/) to release the drag command.

Asterisk Right Mouse Click on speech pad.

Restricting Movement of the JAWS Cursor

Insert R Turn JAWS Cursor Restriction On or Off.

If several application windows are on the desktop, it is possible for them to overlap or totally cover one another. This means that parts of several windows could be visible around the active application window. The PC cursor stays within the active window, which means it will not read
information from the surrounding windows. The JAWS cursor also stays within the active window.

The restriction setting does not affect the movement of the PC cursor. When restriction is turned on, the JAWS cursor is restricted to the active section of the screen where it is currently located. If it is in a dialog box when restriction is turned on, it can only read the active dialog option. When using the JAWS cursor restriction, in order to ensure that the cursor is being restricted to the proper section of the desktop, it is best to do the following:

1. Route the JAWS cursor to the location of the PC cursor with **Insert Minus**.
2. Turn on JAWS cursor restriction, with **Insert R**.

**How to use the JAWS Configuration Manager**

The Configuration Manager contains a Set Options menu. When you choose a Set Options menu item, a dialog opens. The Configuration Manager includes the following menu options: User, Text Processing, Window Classes, Graphics and Symbols, Cursor, **Keyboard**, Braille, and Advanced. These dialogs enable you to configure your applications to your own specifications. Use the hotkey **Insert** (alpha keyboard) 6, or

1. Press **Insert J** to activate the JAWS application.
2. Press Alt U to open the Utility menu item.
3. Press C to open to Configuration Manager.

**Settings Handled by the Configuration Manager**

Use the command for context-sensitive help, **Insert F1**, when the focus is on an element in a configuration dialog, JAWS will speak a help message regarding the nature of the element (e.g., typing interrupt), its function, and its default setting.

- **User Options**
  These include typing echo, screen echo, verbosity level, typing interrupt, reading interrupt, key repeat and Insert key mode.

- **Text Processing**
  These include punctuation mode, filter repeat characters, number processing, list item, mixed case processing, dictionary processing, speak window type first, speak window state first.
Graphics and Symbols
These include graphic verbosity, ANSI character verbosity, graphic dimensions, graphics mode toggle.

• Advanced Options
Among these options is found the "go-to-sleep" checkbox. This can be used to silence JAWS in a particular application. To silence JAWS in a particular application, open the application itself, with JAWS running; open the Configuration Manager and select the go-to-sleep option from the Advanced menu. Save the change. Now, if JAWS is loaded and this application loads in, JAWS will not speak in the application at all, but will in all others.

There are other main types of options, but they relate to advanced use.

How to use the JAWS Keyboard Manager
The Keyboard Manager controls the assignment of keystrokes to JAWS activities. It is important to understand a little about scripts before learning about Keyboard Manager. All JAWS activities assigned to keystrokes are scripts. A script is a small computer program that controls how JAWS reacts and what you hear. To open Keyboard Manager, use Insert (alpha keyboard) 8, or
1. Press Insert J to activate the JAWS application.
2. Press Alt U to open the Utility menu item.
3. Press K to open the Keyboard Manager.

Row to use the JAWS Dictionary Manager
This application allows you to alter the JAWS Dictionary. The JAWS Dictionary is a collection of files that stores all the correctly pronounced words. The Dictionary Manager is the tool that enables you to manage your own JAWS Dictionary files. Press Insert D to start the Dictionary Manager and add words to you dictionary.

Use the Dictionary Manager to alter words for specific applications or all your applications. To save changes to all applications, save the changes to the default.jcf file.
1. Press Insert J to activate the JAWS application.
2. Press Alt U to open the Utility menu item.
3. Press K to open the Keyboard Manager.

How to use the JAWS Frame Manager
You can use Frame Manager to create and work with frames. Frames are boundaries on a screen for which you define a JAWS action. Use a frame to define an area of the window or screen to be spoken automatically.
• Use a frame to define an area of the window or screen to be spoken when a keystroke is pressed.
• Use a frame to define an area of the window or screen for JAWS to ignore.
• Use a frame to define an area of the window or screen for JAWS to treat differently than other areas.

To open Frame Manager, use Insert 9, or
1. Press **Insert J** to activate the JAWS application window.
2. Press Alt U to open the Utility menu item.
3. Press F to open the Frame Manager.

### How to use the JAWS Script Manager

Small script files are created, edited and compiled with Script Manager. A script is a small computer program that controls how JAWS reacts and what you hear. For example, when Insert 5 is pressed, the SayWord script runs. In addition to just saying the current word, it also checks to see if Insert 5 has been pressed twice, in which case it spells the word. Groups of scripts are stored in the script files. There are two basic types of script files: default and application. The default script files contain those scripts and other things that are always available. Application script files contain scripts and other things that are only available when a particular application program is running.

1. Press **Insert J** to activate the JAWS application.
2. Press Alt U to open the Utility menu item.
3. Press S to open the Script Manager.

### Notes:

Pricing
For extensive information about pricing, site licenses and software maintenance agreements (SMA), use this web address: [www.hj.com/JFW/JFWPricing.html](http://www.hj.com/JFW/JFWPricing.html)

Installation:
Windows NT 4.0 must have Service Pack 4 installed to use MS Active Accessibility or there will be differences in functionality between the Win 95 and NT versions in applications that use Active Accessibility, e.g., MS Office.

You must have workstation administrative permissions when installing JFW. Specifically you must have the permissions necessary to write into the registry. You must uninstall any product which places entries in the video chain of NT. Most prevalent of these products are remote control products such as Remotely Possible, PC Anywhere, etc.

If you are having trouble installing JFW or you are in a blue screen cycle, get to a point where you can enter a WinMSD from the run on the start menu. The video chain we are referring to is the list of file(s) in the driver section of the display tab. Usually the actual driver in use is a DLL at the rightmost...
position of the chain. Currently JFW needs to install its driver JFWVID.DLL immediately to the left of the actual driver. If you find another entry between JFWVID.DLL and the target driver, JFW will not work.

It is also possible to unload the JFW NT video driver with the following command from a command line window: c: \jfw \drjaws /setjv=r
JFW will reset itself when restarted. To reinstall the driver use the following command: c:\jfwldrjaws /setjv=i

When installing on a dual boot system with NT and some other OS, you must first install under NT. After installing under NT, you can reboot to Win 95 or Win 98 and reinstall JFW. This will avoid authorization conflicts.

Note that with JFW NT version, the authorization must be on the hard disk and not on a floppy as is possible with the Win 95 version.

Network:
Site license costs: for 5 users, $2,400; for 10 users, $4,000; for 15 users, $6,000; for 20 users, $6,500. The SMA or Software Maintenance Agreement is ten percent of the JFW license price and entitles the district to the next two JFW upgrades.

Network Authorization

Now network users of JFW 3.5 with proper authorization can work on any computer in their network as long as the computer is mapped to the drive containing the authorization key. This feature applies to Windows 95 and 98, Windows NT, Novell, and Unix servers and stations. For information on obtaining network authorization, contact Henter-Joyce.
## JAWS ver. 3.5
### PC CURSOR FUNCTIONS

<table>
<thead>
<tr>
<th>Num Lock Key</th>
<th>/ left mouse button</th>
<th>right mouse button</th>
<th>-</th>
</tr>
</thead>
<tbody>
<tr>
<td>off</td>
<td></td>
<td></td>
<td>JAWS cursor on</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Ins + - = routes to PC. cursor</td>
</tr>
</tbody>
</table>

### 7 Home
Reads beginning of text line or first item in first box. Ins + 7 = reads from beg. of line up to cursor, but not including cursor.

### 8 T
Reads prior line.
Ins + 8 = reads whole line

### 9 PgUp
Moves insertion point up one line.
Ins + 9 = reads from cursor to end of line.

### 4 4-
Select previous icon or menu item or move insertion point to previous character.
Ins + 4 = reads previous word

### 5
Reads current character.
Ins + 5 = reads current word.
Ins + 5 twice to spell word.

### 6 +
Select next icon or menu item or move insertion point to next character.
Ins + 6 = reads next word

### 1 END
Reads end of line or list box.
Ins + 1 = reads top line of the window

### 2
Reads next line down below.
Ins + 2 = reads to end of file or box

### 3 PgDn
End of line or list box
Ins + 3 = reads last line of the window (status line).

### Enter

### O Insert
With Alt, toggle between Insert and Overwrite mode.

### Delete
With Alt = speaks active cursor
# JAWS ver. 3.5

## JAWS CURSOR FUNCTIONS

<table>
<thead>
<tr>
<th>Num Lock Key - off</th>
<th>/ left mouse button</th>
<th>right mouse button</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- single click selects</td>
<td>- right button mouse click</td>
</tr>
<tr>
<td></td>
<td>- double click chooses</td>
<td>- ins + * = locks right mouse button</td>
</tr>
<tr>
<td></td>
<td>- shift + / = locks left mouse button</td>
<td></td>
</tr>
</tbody>
</table>

### 7 Home
Reads beginning of line.
Ins + 7 = reads from beg.
of line up to cursor, but
not including cursor.

### g T
Reads previous line.
Ins + 8 = reads whole line

### 9 PgUp
Reads top of application or child window.
Ins + 9 = reads from cursor to end of line.

### 4 .
Reads previous character.
Ins + 4 = reads previous word

### 5
Reads current character.
Ins + 5 = reads current word.
Tap twice to spell word.

### 6 4
Reads next character.
Ins + 6 = reads next word

### 1 END -
Goes to end of line and reads last word or graphic.
'Ins + 1 = reads top line of the window

### 3 PgDn
Reads next line down below.
Ins + 2 = reads from cursor to end of window (say all mode).
Ctrl + 2 = reads active child window.

### Enter

### 0 Insert
With Alt, toggle between Insert and Overwrite mode.

### . Delete
Deletes character at cursor
With Alt = speaks active cursor

---

**JAWS cursor** on
Ins + - = routes to PC cursor

**PC cursor** on
Ins. + + = routes to JAWS cursor

---

**Insert**

**Delete**
Introduction

Internet Explorer 5.0 is a suite of tightly integrated programs that connects a computer to information that is available through the Internet and. Internet Explorer not only acts as a browser to display the data, but it also helps the user find, incorporate, and interact with that data. It is recommended to use IE 5.0 with JAWS for Windows 3.31 or later. IE 4.01 is still supported as it has been in earlier versions of JFW, but JFW takes advantage of newer technology that is only available in IE 5.0. These applications run under Microsoft Windows 95, Windows 98, and Microsoft Windows NT. When using Microsoft Windows NT, Service Pack 4 or later is required.

Getting Started

Make sure that IE is installed properly on and running correctly. It is recommended not to install the Active Desktop component with IE. If the IE toolbar is used, include text labels on the buttons. Default IE settings include text labels.

Open the Internet Explorer settings panel:

1. Open the IE Tools menu with Alt T.
2. Tap o to go to Internet Options.
3. Enter Alt E to move to the Accessibility button in this dialog box.
4. Make sure "Ignore Colors..." is selected.
5. Close this panel by selecting the OK button.
6. Use Control Tab to get to the Advanced settings tab.
7. Under the Accessibility section, make sure the following are checked:
   - Always expand ALT text for images
   - Move system caret with focus
8. Under the Browsing section, make sure the following options are NOT checked:
   - Show Channel bar at startup
   - Show friendly URLS
   - Use smooth scrolling
   - Enable page transitions
New JFW 3.5.37 Internet Explorer 5.0 Support

**Screen follows the Virtual PC Cursor**
The screen will now scroll to track the location of the Virtual PC cursor.

**Persistence of Settings in List of Links**
If the user filters or organizes their list in the Link List dialog, this setting will remain until they change it or exit JFW. The default setting that ships with JFW is All Links in Tab Order.

**Improvements to Links List**
The Links List Dialog status line has been changed. The status line no longer contains the display filter or the sort order, as these are easily accessible by tabbing around the dialog. The status line now contains the URL for selected link. This enables the user to determine which of several links with the same text name they want to activate or move to, i.e., which "Click Here" is the right one to select.

**Graphic Announcement Toggle**
The user now has the ability to turn off the announcement of graphics that are not links. The user is able to toggle this through the HTML Settings Dialog in the Configuration Manager. The choices are: No Graphics, Tagged Graphics, and All Graphics. The default setting is All Graphics.

**ALT Text and Screen Text Toggle**
Often, the ALT Text of links on a Web page is different from the text shown on the screen. Depending on the Web page, either can be more descriptive. The user now has the choice to select which of these they would like JFW to seek as the primary text to speak.

If the user selects Screen Text, JFW will use the screen text if it exists, otherwise, it will use the ALT Text. If neither exists it will use the URL.

If the user selects ALT Text, JFW will always use the ALT Text, if available, otherwise, it will revert to the screen text. If neither exists it will use the URL.

The user is able to toggle this temporarily through the Verbosity dialog, or permanently through the HTML Settings dialog in the Configuration Manager.
**JAWS Keystrokes for Internet Explorer 5.01**

**Insert A**
AddressBar
Reads the Address bar while maintaining the place on the page.

**Insert AA**
Moves the JAWS cursor to the address bar.

**Alt D** (an IE 5 keystroke)
Select the text on the Address bar.
Type in a new address, or copy or cut and paste to the clipboard.

**Ctrl Insert Home**
FocusToFirstField
Moves to the first input field in the page and speaks it. If no form field is found, JFW reports, "Input Field Not Found."

**Alt Left Arrow or Backspace**
GoBack
Loads the previously opened Web page and says the line the user was on prior to leaving this page.

**Alt Right Arrow**
GoForward
Loads the next opened Web page and announces it. JFW places the Virtual PC cursor at the top of the page and says the first line. This is useful when browsing pages.

**Ctrl F**
IEFind
Calls up the Find dialog.

**Tab**
MoveToNextLink
Moves to the next hypertext link or control in the page. Activate a link by tapping **Enter**.

**Insert Enter**
MoveToNonLinkText
Moves to the next block of non-linked text that is larger than 50 characters.
(when using the virtual cursor)
Shift Tab
MoveToPriorLink
Moves to the prior hypertext link or control in the page. Activate the link by tapping Enter.

Ctrl Tab
NextFrame
Moves to the frame and says the frame label.

Ctrl Shift Tab
PriorFrame
Focuses and reads the previous frame in the HTML order.

Insert Esc
RefreshScreen
Refreshes the screen and updates the state of information of the Off Screen Model.

Ctrl Insert Down Arrow
ReadCurrentScreen
Reads the body of the page from the top with the JAWS cursor.
Note: This is only available in non-virtual cursor mode.

Ctrl Page Down
ReadNextScreen
Reads the next screen: does a PageDown and begins reading with the JAWS cursor. Note: This is only available in non-virtual cursor mode.

Ctrl PageUp
ReadPriorScreen
Reads the prior screen. Does a PAGE UP and begins reading with the JAWS cursor. Note: This is only available in non-virtual cursor mode.

Insert F5
ReformatDocument
Reformats multiple column pages to be more readable with speech. Rearranges multiple column pages to read in a linear fashion. IE columns are read one after another. Note: This is only available in non-virtual cursor mode.

Insert Tab
SaySelectedLink
Says the focused link or control. If in a dialog, speaks the current control. If in a Web page, announces the link or control with focus.
Insert F9
SelectAFrame
Brings up a dialog containing a list of the frames present in the page. Select a frame from the list and press Enter. The focus moves to the frame selected and speaks its content.

Insert F7
SelectALink
Brings up a JFW dialog containing all of the links present on the page. Select a link by using the Arrow keys or the first letter of the link. Press Enter to open the selected link. TAB between the various controls in the Select A Link dialog.

Insert F8
IE Tool Bar access
Allows access to the IE toolbar. While in IE, brings up a dialog box that contains a list of every button that appears on the toolbar. In this dialog, select one of the buttons on the toolbar and press Enter to choose it.

Insert Z
VirtualPCCursorToggle
Toggles the Virtual PC cursor mode On or Off. When in a web document, this command toggles between the Conventional mode and the Virtual PC cursor interface.

Helpful Hints

When working in Internet Explorer 5.0 with JFW, the user works in one of three modes: Virtual PC cursor mode, Forms mode, or Conventional mode.

It is not possible to use the Context Detection (Insert F) option when using the virtual cursor.

Virtual PC Cursor Mode

The Virtual PC cursor is activated automatically when IE 5 opens, and JFW begins speaking the text on the screen as soon as the page finishes loading. If the newly opened page is loaded, JAWS announces the presence of frames, links, and forms on the page. JAWS will announce if there are no frames, links, or forms on the page.
The Virtual PC cursor works in the Internet Explorer 5.0 environment in much the same way that the PC cursor does in other applications. The Virtual PC cursor responds to normal screen reading keys in the same way, but there is no visual indication on the area of the screen that is being read. In addition, the screen does not automatically scroll, so to bring up text that is out of screen range, use **Insert Esc.**

**Caution:** Manually starting to read before the loading has finished often results in less than all of the text being available.

When reading a Web page with the Virtual PC cursor, select text using the standard Windows text selection keys (e.g., **Shift Right Arrow** to select a character; **Control Shift Right Arrow**) to select word; there is no visual feedback of what is being selected. The SaySelectedText script (**Insert Shift F2**) speaks the text that has been selected.

When a page with frames first comes up, all frames are readable in sequential order. Check with **Insert Fl** and JAWS announces: "The page contains frames."

As the user enters a frame, JAWS says its name, e.g., "Navigation Frame," JAWS announces the frame name and "end" when the user leaves a frame.

Ctrl **Home** brings the top of the document into view on the visual screen, Ctrl **End** brings the bottom of the document into view on the visual screen, **PageDown** moves down 24 lines, and **PageUp** moves up 24 lines. **SayAll** (**Insert 2** on numpad) in line mode reads the document from top to bottom. To stop this reading, tap Ctrl to stop the SayAll function. JAWS positions the cursor near the last item read.

When reading text on a Web page, each link appears to be on its own line, even though this may not be true on the screen. Visited links are identified as "visited." They are also properly categorized as visited in the Links List dialog.

Note: When JAWS reads "strange things," the following is probably occurring: when JFW encounters a link that does not have any text associated with it, one of two things is announced. If the link is a CGI link, the name of the graphic is spoken. Otherwise, the last directory component and the file name of the URL is spoken instead.

To quickly skip past headers, press **Insert Enter.** This moves the user down through the page to the first text of at least 50 characters that is not a link. When it arrives at the text, the current line is read.
When the cursor is on a line with a link, pressing **Enter** or **Numpad Slash** activates that link. Subsequently, pressing **Backspace** moves back to the last position on the last page read.

When using the virtual cursor and a link on the screen that has an ALT tag is encountered; JAWS will read the ALT tag.

**How to Turn Virtual Cursor On and Off**

It is not possible to use the reformat option (**Insert F5**) in Internet Explorer (IE) when the virtual cursor is in use. Therefore, if the user wishes to work in the web environment using the JAWS interface of version 3.30, which allows reformatting of web pages, it is necessary to turn off the virtual cursor.

1. With Internet Explorer open, enter Insert 6. The configuration file for IE, browseuijcf, is opened by the Configuration Manager. (To make this change throughout all applications, load the default configuration file from the Configuration Manager file menu and then do the following.)
2. Enter **Alt S** to open the **Set Options** menu.
3. Tap a for **Advanced Options**.
4. Enter **Alt V** to toggle the virtual cursor state off.
5. Save the **browseuijcf** file by entering Ctrl S.
6. Close the **Configuration Manager** with **Alt F4**.

**Forms Mode**

With the Virtual PC cursor positioned on a form field, press **Enter** or the **Num Pad Slash** key to switch to **Forms Mode**. JAWS will announce "Forms Mode On," and speak the name of the control which has cursor focus. At this juncture, tap **Enter** to activate the PC cursor at the current control.

Possible example: If the user is on a button, the button is pressed. If the user is on a checkbox, the state of the checkbox is toggled. If on a radio button that is unchecked, then the radio button is checked; however, if it was already checked, it remains unchanged. In an edit box, the PC cursor is placed at the top of the edit field. In a combo box, the first item is selected.

**Tab** and **Shift Tab** must be used to move between fields in forms mode. When using these keys for navigation, the natural tab order is used, including any links
that may appear between fields. As JAWS lands on the different controls, it announces the new control, such as a link or a field.

While in forms mode it is possible to edit fields using the PC cursor as done normally.

To exit Forms Mode, press **Num Pad Plus** to return to the Virtual PC cursor.

**Note:** JFW remains in Forms Mode until the virtual PC cursor is activated or a new page is displayed, whichever comes first. **Insert Esc** also returns the user to virtual cursor mode and moves the position of the virtual PC cursor to the first control on the current page.

Tip: Return to the Virtual PC cursor using the **NumPad Plus**. This turns Forms Mode off.

**Link List Dialog**

**When in IE 5.0, bring up the Link List dialog** by pressing **Insert F7**. This brings up the Links List view. By default this list is sorted in tab order and shows all links. This List view lists the links on the current page according to the filter and sort order set by the other controls in this dialog. Each time it comes up, it defaults to listing all links in tab order. If the links have the same name but point to different locations, each one is listed in this list view.

Visited links are determined by what IE indicates as a visited link. If **IE keeps in** memory what links have been visited in the (for example) last 10 days, a link will display as visited until the 10 days are up. It is possible for the user to adjust the time IE keeps links as visited.

The Links List dialog has a display area where in the lower portion of the dialog box. Three radio buttons affecting link display are placed there: All **Links**, which if selected shows all links. **Visited Links Only**, which if selected shows visited links. **Unvisited Links**, which if selected shows unvisited links.

The Links List dialog has radio buttons which allow the user to set the way the Links List dialog box displays links. **In Tab Order**, which if selected, lists the links in tab order; and Alphabetically, which if selected lists the link alphabetically.
There are also three buttons which assist the user in **navigating: Move To Link** which if selected moves to a link; and **Activate Link** which if selected moves to an activated link; and **Cancel**, which if selected closes the Links List dialog.

**Alt M**  
**Move to Link button**  
When activated, closes the dialog box and moves the Virtual PC cursor to that link on the current Web page. Use the navigational keys to explore around the link.

**Enter**  
**Activate Link button**  
Closes the Link List dialog box and activates the selected link. It is also the default button.

The Display **group box allows the user to select** the radio button to filter the displayed list to display all links (default), visited links only, or unvisited links. It is possible to tab to this group box or use hot keys to change the settings without leaving the list view. Hot keys to change the link display are as follows:

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT L</td>
<td>Display All Links</td>
</tr>
<tr>
<td>ALT V</td>
<td>Display Visited Links Only</td>
</tr>
<tr>
<td>Alt U</td>
<td>Display Unvisited Links</td>
</tr>
</tbody>
</table>

The links list can have the links appear in or alphabetically. Tab to this **group box** or use hot keys to change the settings without leaving the list view. Hot keys are as follows:

<table>
<thead>
<tr>
<th>Hot Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT T</td>
<td>Display links in tab order (default)</td>
</tr>
<tr>
<td>ALT P</td>
<td>Display links in alphabetical order</td>
</tr>
</tbody>
</table>

In the Links List dialog it is possible to close the dialog box and return to current position on a web page by activating the Cancel button with **Alt C** or tapping **Esc**.

**Working in Conventional Mode (as in IE 4.01)**

**Note:** To temporarily toggle between Virtual PC cursor and PC cursor, press **Insert Z**.

By turning off the Virtual Cursor, it is possible to navigate in IE using the JAWS cursor and reformatting options that were used by JFW in IE 4.01. This functionality is not available if the Virtual PC cursor mode is enabled. To find out more about how the JAWS conventional mode works, as in IE 4.01, see the
JFW Help topic "Using JAWS with Popular Applications" section on using JAWS with IE 4.01.
Web Based Activities to Learn to Use JAWS

The High Tech Center Training Unit has developed a series of web pages designed to be used with JAWS: www.htctu.fhda.edu/readweb/readweb

The following text accompanies these activities:

Reading Web Pages with JAWS 3.5.37

The California community colleges Distance Education Access Guidelines for Students with Disabilities require that all web-based instructional resources be WAI Priority 1 compliant. A large number of Priority 1 guidelines address access considerations for persons who are blind.

Recent additions to JAWS version 3.5.37 greatly improve the capacity of this screen reader navigate more complex web pages. The web pages provide examples of the types of web-page formats which can now be read with JAWS and the JAWS keystroke commands for reading them.

These example pages are meant to be explored using Microsoft Internet Explorer 5.0 and JAWS version 3.5.37. JAWS makes extensive use of the "accessibility hooks" built into Internet Explorer 5.0 and will not provide the same level of access when used with Netscape Navigator or earlier versions of Internet Explorer. Please remember that pressing the Ctrl key will stop JAWS reading, pressing the Tab key will move to the next link and pressing Shift Tab will move to the previous link.

These activities illustrate how the power of the new Virtual Cursor has increased the capability of JAWS to read complex web pages.

Important: JAWS reading commands use the Num Pad keys.
# Reading Web Pages with JAWS 3.5.37 - Internet Explorer 5.0

## Reading Letters and Words

<table>
<thead>
<tr>
<th>Action</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read next character</td>
<td>Right arrow</td>
</tr>
<tr>
<td>Read previous character</td>
<td>Left arrow</td>
</tr>
<tr>
<td>Read current character</td>
<td>Num Pad 51</td>
</tr>
<tr>
<td>Read next word</td>
<td>Insert Right Arrow</td>
</tr>
<tr>
<td>Read previous word</td>
<td>Insert Left Arrow</td>
</tr>
<tr>
<td>Read current word</td>
<td>Insert Num Pad 5</td>
</tr>
</tbody>
</table>

## Reading Lines and Sentences

<table>
<thead>
<tr>
<th>Action</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read next line</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Read prior line</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Read current line</td>
<td>Insert Up Arrow</td>
</tr>
<tr>
<td>Read next sentence</td>
<td>Alt Down Arrow</td>
</tr>
<tr>
<td>Read prior sentence</td>
<td>Alt Up Arrow</td>
</tr>
<tr>
<td>Read current sentence</td>
<td>Alt Num Pad 5</td>
</tr>
</tbody>
</table>

## Reading Paragraphs and Pages

<table>
<thead>
<tr>
<th>Action</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read next paragraph</td>
<td>Ctrl Down Arrow</td>
</tr>
<tr>
<td>Read prior paragraph</td>
<td>Ctrl Up Arrow</td>
</tr>
<tr>
<td>Read current paragraphs</td>
<td>Ctrl Num Pad 5s</td>
</tr>
<tr>
<td>Move to top of page</td>
<td>Ctrl Home</td>
</tr>
<tr>
<td>Move to bottom of page</td>
<td>Ctrl End</td>
</tr>
<tr>
<td>Read to end of page</td>
<td>Insert Down Arrow</td>
</tr>
</tbody>
</table>

---

Page 54
Reading Web Page Tables with JAWS 3.5.37

<table>
<thead>
<tr>
<th>ACTION</th>
<th>KEYSTROKES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reads the row and column coordinates, followed by the cell contents</strong></td>
<td><strong>Alt Ctrl Num Pad 5</strong></td>
</tr>
<tr>
<td><strong>and then the appropriate row and column headings.</strong></td>
<td></td>
</tr>
<tr>
<td>Moves to the next cell in the same row and then announces the column header followed by cell contents and then the column number.</td>
<td><strong>Alt Ctrl Right Arrow</strong></td>
</tr>
<tr>
<td>Moves to the previous cell in the same row and then announces the column header followed by cell contents and then the column number.</td>
<td><strong>Alt Ctrl Left Arrow</strong></td>
</tr>
<tr>
<td>Moves to the cell below the current cell and reads the row heading followed by cell contents and then the row number.</td>
<td><strong>Alt Ctrl Down Arrow</strong></td>
</tr>
<tr>
<td>Moves to the cell above the current cell and then announces the row heading followed by cell contents and then the row number.</td>
<td><strong>Alt Ctrl Up Arrow</strong></td>
</tr>
<tr>
<td>Moves to first cell in current table and reads row and column coordinates followed by contents of the cell.</td>
<td><strong>Alt Ctrl Home</strong></td>
</tr>
<tr>
<td>Moves to the last cell in current table and reads row and column coordinates followed by contents of the cell.</td>
<td><strong>Alt Ctrl End</strong></td>
</tr>
</tbody>
</table>

Using JAWS 3.5.37 to Read Forms

<table>
<thead>
<tr>
<th>ACTION</th>
<th>KEYSTROKES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moves to the first input field in the page and speaks it. If no form field is found, JAWS reports, &quot;Input Field Not Found.&quot;</td>
<td><strong>Ctrl Insert Home</strong></td>
</tr>
<tr>
<td>With the Virtual PC cursor positioned on a form field, enters Forms Mode and speaks the name of the control which has cursor focus. Press <strong>Enter</strong> to activate the PC cursor at the current control.</td>
<td><strong>Enter or Num Pad Slash</strong></td>
</tr>
<tr>
<td><strong>To move to next field in forms mode. When using these keys for navigation, the natural tab order is used, including any links that may appear between fields. As JAWS lands on the different controls, it announces the new control, such as a link or a field.</strong></td>
<td><strong>Tab</strong></td>
</tr>
<tr>
<td>To move to previous field in Forms Mode</td>
<td><strong>Shift Tab</strong></td>
</tr>
<tr>
<td>To exit Forms Mode and return to the Virtual PC cursor</td>
<td><strong>Num Pad Plus</strong></td>
</tr>
</tbody>
</table>
Reading frames with JAWS 3.5.37

JAWS 3.5.37 is capable of identifying the presence of frames on a web page and moving to the location of each frame. Use normal JAWS web keystrokes for reading the content of the frame.

<table>
<thead>
<tr>
<th>Action</th>
<th>Keystroke(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announce the presence of frames on the page</td>
<td>Insert F1</td>
</tr>
<tr>
<td>Bring up a dialog box containing a list of</td>
<td>Insert F9</td>
</tr>
<tr>
<td>the frames present on the page. Use the</td>
<td></td>
</tr>
<tr>
<td>Up/Down arrow keys to select a frame from</td>
<td></td>
</tr>
<tr>
<td>the list and press ENTER. The focus will</td>
<td></td>
</tr>
<tr>
<td>move to the frame selected and speak its</td>
<td></td>
</tr>
<tr>
<td>content.</td>
<td></td>
</tr>
<tr>
<td>Move to next frame</td>
<td>Ctrl Tab</td>
</tr>
<tr>
<td>Move to previous frame</td>
<td>Shift Ctrl Tab</td>
</tr>
</tbody>
</table>

Reformatting web pages with JAWS 3.5.37

Complex web pages can be automatically reformatted for better screen reader access. Press Insert z to turn off the Virtual PC cursor then press Insert F5 to reformat the screen.

Display all page links with JAWS 3.5.37

- For a quick display of all links on the active web page in their tab order, press Insert F7
- Use the Up and Down Arrow keys to navigate the list and hear the link names
- Use the Enter key to go to a selected link.
Basic Web Navigation

JAWS and Internet Explorer 5.0 provide a variety of ways to perform basic web page navigation. The following keystrokes outline some of these basic functions.

<table>
<thead>
<tr>
<th>Move to and read address bar</th>
<th>Insert a</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move JAWS cursor to address bar</td>
<td>Insert a a (quickly)</td>
</tr>
<tr>
<td>Select address bar</td>
<td>Alt d</td>
</tr>
<tr>
<td>Search page content</td>
<td>Ctrl Insert f</td>
</tr>
<tr>
<td>Next web page</td>
<td>Alt Right Arrow</td>
</tr>
<tr>
<td>Previous web page</td>
<td>Alt Left Arrow</td>
</tr>
</tbody>
</table>

Notes:
**Kurzweil 1000 5.0 (Win 95/98/NT)**

**Publisher:** Kurzweil Educational Systems, Inc.  
411 Waverley Oaks Road  
Waltham, MA 02154  
800-894-5374  
http://www.kurzweiledu.com

**System Requirements:**
- Pentium 133 MHz processor or higher  
- 24 MB of RAM (32 MB recommended)  
- 60 MB available hard disk space available  
- 6X CD-ROM drive  
- Single-pass color flat-bed scanner (TWAIN compatible)  
- Sound Blaster sound card or compatible  
- Microphone, if you wish to use the voice command option  
- Full size keyboard or 17-button Kurzweil 1000 keypad  
- Windows 95/98/NT operating system

**Description:**
The Kurzweil 1000 is a computer-based reading system that converts printed material into speech. Users navigate through their documents by using the optional keypad that comes with it or by using the numeric keypad on a full size keyboard. In addition to reading documents, users can use dictionary and spelling tools to enhance their reading. Kurzweil 1000 documents can also be managed from the keypad.

The Kurzweil 1000 now supports Braille output as well as print text. This option resides in the Print dialog box. The capability of reading multiple page TIFF files has also been incorporated into version 4.0.

**Recommended Uses:**
The Kurzweil 1000 was designed for non-sighted users, and is useful in any setting where students need access to print materials. The difference between the Kurzweil 1000 and the 3000 is that the latter, designed for persons with learning disabilities, supports graphics, and allows students to visually read on an exact scan of a page.
**Basic Use:**

1. Basic use involves using the Reading Keypad to first scan a document then read it. Refer to the picture below to find these keys. Insert your document into the scanner facedown. Tap the Start & Stop Scan button (plus key on numeric keypad) to begin scanning.
2. After the page has been scanned, use the Start & Stop Reading button (Zero key on numeric keypad) to read through the page.
3. To learn about the other keys, use the Help and Status key.

### The Reading Keypad

<table>
<thead>
<tr>
<th>Cancel</th>
<th>Erase Text</th>
<th>Dictionary</th>
<th>Accept</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume Up</td>
<td>Speed Up</td>
<td>Reading Unit</td>
<td>Start Stop Scan</td>
</tr>
<tr>
<td>Volume Down</td>
<td>Speed Down</td>
<td>Column Melt</td>
<td></td>
</tr>
<tr>
<td>Rewind</td>
<td>Forward</td>
<td>Go To Page</td>
<td>Help Status</td>
</tr>
<tr>
<td>Start &amp; Stop Reading</td>
<td>Spell</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>No Function</th>
<th>Paste Page</th>
<th>No Function</th>
<th>Change Keypad Layer</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>Insert or Rescan</td>
</tr>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>Enable Voice Command</td>
</tr>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>Bookmark</td>
<td>No Function</td>
</tr>
<tr>
<td>Rewind by Unit</td>
<td>Forward by Unit</td>
<td>Go To Bookmark</td>
<td></td>
</tr>
<tr>
<td>Rewind by Unit</td>
<td>Forward by Unit</td>
<td>Go To Bookmark</td>
<td></td>
</tr>
<tr>
<td>Shift</td>
<td>arm with Mnemonics</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Reading Keypad

Reading Keypad, Shifted
**Intermediate Use:**

1. Below is the File Management Keypad. To change keypads, press and hold down the Start and Stop Reading key, then press and release the Accept key, then release Start and Stop Reading.

**File Management Keypad**

<table>
<thead>
<tr>
<th>Cancel</th>
<th>Favorite Folders</th>
<th>Favorite Files</th>
<th>Accept</th>
<th>No Function</th>
<th>Delete Favorite Folder</th>
<th>Delete Favorite File</th>
<th>Change Keypad Layer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Folder or A through E</td>
<td>New Folder or F through J</td>
<td>Delete Folder or K through 0</td>
<td>No Function</td>
<td>Change Folder under Current</td>
<td>No Function</td>
<td>Function</td>
<td>No Function</td>
</tr>
<tr>
<td>Open File of P through T</td>
<td>Close File or U through Z</td>
<td>Delete File or 0 through 4</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
</tr>
<tr>
<td>Save File of 5 through 9</td>
<td>Save Fde As or Space</td>
<td>Export File Format</td>
<td>Help Status</td>
<td>No Function</td>
<td>Save in Expolt Format</td>
<td>No Function</td>
<td>Help Status</td>
</tr>
<tr>
<td>Start &amp; Stop Reading</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
</tr>
</tbody>
</table>

**File Management Keypad**

**File Management Keypad, Shifted**
Advanced Use:

1. Below is the Settings Keypad. Change to this keypad and use the **Help** & **Status** key to learn about these keys.

### Settings Keypad

<table>
<thead>
<tr>
<th>Function</th>
<th>Setting Keypad</th>
<th>Settings Keypad, Shifted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Page Orientation</td>
<td>Numeric keypad Layout</td>
</tr>
<tr>
<td>Reading Voice</td>
<td>System Voice</td>
<td>Progress Messages</td>
</tr>
<tr>
<td>Dynamic Threshold</td>
<td>Scan Mode</td>
<td>No Function</td>
</tr>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
</tr>
</tbody>
</table>

### Settings Keypad, Shifted

<table>
<thead>
<tr>
<th>Function</th>
<th>Setting Keypad</th>
<th>Settings Keypad, Shifted</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
</tr>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
</tr>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
</tr>
<tr>
<td>No Function</td>
<td>No Function</td>
<td>No Function</td>
</tr>
</tbody>
</table>

**Notes:**

Be sure to read the installation notes, especially if you have a previous version or the Kurzweil 3000 installed. In general, the rule is to install the older program first, then the newer version.

The Kurzweil 1000 no longer has copy protection so no key disk is needed for installation. If installing on Win NT, be sure to obtain the NT drivers for your scanner. Also note that Win NT currently does not support USB scanners.
Kurzweil 3000 4.0 (Win 95/98/NT)

Publisher: Kurzweil Educational Systems, Inc.
411 Waverley Oaks Road
Waltham, MA 02154
800-894-5374
http://www.kurzweiledu.com

Retail Cost: $ 1995.00

System Requirements:

- Pentium PC Processor (preferably 166MHz or higher)
- 32 MB RAM - Black and white scanning
- 64 MB RAM - Color scanning
- 70MB of available hard disk space (with 80 MB reserved as swap space for virtual memory)
- 6X CD-ROM drive
- Sound Blaster or compatible sound card (16 or 32 bit)
- Microphone and speakers
- SVGA Monitor (resolution of 800x600 or higher)
- Fully TWAIN compatible scanner (Scan/Read only)
- Full size keyboard and mouse
- Windows 95/98/NT operating system

Description:

The Kurzweil 3000 is a computer-based reading system that converts printed material into speech. Users can hear printed words spoken aloud as they read them on the computer screen. In addition to reading documents, users can use dictionary and phonetic spelling tools to enhance their reading. Scanned pages appear on the screen as they appear in the original material. As the Kurzweil 3000 reads, it highlights each word and its context. The reading voice, background/foreground colors, and text size are easily adjustable.

Good user interface

1. New, brighter icons.
2. Easy access to more features, like document and page thumbnails.
3. Re-organized option tabs.
4. A customizable right button menu.

Study skills and authoring tools

6. Voice notes.
8. Improved note handling, including numbered note anchors.
10. Word prediction.
12. User selectable block or word highlighting for typed documents.
13. Improved dictionary display.
15. Syllable highlighting in the phonetics display.
16. A Synonyms button on the main toolbar (at resolutions of 1024 x 768 or higher).

Many scanning features
17. The newest version of ExperVision's optical character recognition (OCR) software.
18. Enhanced document feeder support.
20. Scan area option.

Good editing features
22. Undo feature (undo up to 100 edits in typed documents).
23. Image selector.
24. Clipboard reader.
25. Extract text, notes, and/or highlights.
26. Zone editor.

Test taking features
27. Password control for dictionary, thesaurus, spell-checker, and word-prediction features.
28. Pause at Bookmarks.

View and navigation features
29. Thumbnail display of scanned document.
30. Optional multiple-word display in Magnifier window.
31. Annotation display/hide feature.
32. Go To page dialogue.

Recommended Uses:
The Kurzweil 3000 was designed for sighted users who have difficulty reading. It could be used in any setting where students need access to print materials. It may also serve as a writing environment for users who would benefit from its special features: Because there are many on-screen controls available, it is not as suitable as a reading machine for non-sighted students as the companion product the Kurzweil 1000 which provides easy access for non-sighted users.

Basic Use:
1. Start the Kurzweil 3000. Enter your name if prompted. A window appears with a number of menus, buttons, and combo boxes.
2. Run the mouse pointer over the buttons, pausing over each without clicking and read the tool tips that appear which describe each button's function.

3. To scan a document, place it in the scanner and click the **Scan** button.

4. After the image of the document appears on the screen, resize it to your desired size by choosing a percentage in the **Zoom** box or by clicking on the little arrows on the box.

5. Read the document by clicking on the **Pause** button to be clicked when you wish to stop reading.

6. To get more information on a word, highlight any word in the document by double-clicking on it. Click on the **Dictionary** button in the toolbar.

7. Click the **Read** button to hear the definitions read aloud. To see a list of words with similar meanings, click **Get Synonyms**.

**Intermediate Use:**

1. Click the right mouse button in the document to see a context menu of choices to make. This method may prove to be quicker.

2. To select a reading unit, choose from the **Read By** list box either by word, by phrase, by sentence, by line, or by paragraph.

3. To select a reading mode, choose from the **Read Mode** list box. Continuous mode will read until you stop it with a mouse click or clicking on the pause button. If you choose Self-Paced, reading will pause at the end of whatever reading you have selected.

**Notes:**

**Installation:**

The installation is very simple, just insert the CD and follow the on-screen directions. The authorization floppy disk must be in the A: drive during installation when it is automatically installed. There are three authorizations on the floppy disk. If you need to uninstall, there will be a step in the process that places the authorization back on the floppy disk.

However, if you have a previous version or a version of Omni/Kurzweil 1000 the sequence of installation becomes important. As a general rule, install the older of the Kurzweil programs first, then the newer one to avoid conflicts.

If installing on Win NT, be sure to obtain the NT drivers for your scanner.
Publisher:  
Ai Squared  
P.O. Box 669  
Manchester Center, VT 05255  
(802) 362-3612  
http://www.aisquared.com/

Retail Cost see notes section

System Requirements:  
486 or higher processor; Windows 3.1 or 95/98; 16,256 or High Color display driver; minimum 8 MB RAM (16 MB preferred); Windows sound card or SSIL speech synthesizer (required for levels 2 and 3 only).

Description:  
ZoomText Xtra comes in two levels: Level 1 is a screen magnifier for the Windows 95/98 environment. Level 2 offers a fully integrated magnifier and screen reader, designed specifically for the low-vision computer user.

Another innovative feature of ZoomText Xtra is its document reading module, called DocReader. Existing in all product levels, DocReader is a full-screen environment for reading text from any Windows application. DocReader can automatically read through complete documents, including web pages and email.

Recommended Uses:  
ZoomText is intended for use by persons with low vision. It may also be of value to individuals with learning disabilities. ZoomText has been designed so that there is a corresponding hot key for every selection that is generated by a mouse click. Check the documentation for the extensive lists of hot keys. A productive ZoomText user will more than likely use some hotkeys to generate frequently repeated actions.

Basic Use:  
1. To start ZoomText, choose the ZoomText icon from the Start menu.  
2. When ZoomText is active, pressing Alt Delete turns it off. To turn ZoomText back on, press Alt Insert.  
3. When ZoomText is active, pressing Alt Insert or Ctrl Shift U will display the ZoomText User dialog box. Options may be selected from menus or from Tool icons. Selections may be made from the keyboard or with a mouse.
4. Choose **Contents** from the **Help** menu and browse through the excellent descriptions of the programs functions.

**Intermediate Use:**

**Enlarging and Changing Text Size**
Text may be enlarged in two ways: from the keyboard, Alt followed by the **Plus** or **Minus** key will enlarge or reduce text size.

From the ZoomText menu bar: from the **Options** menu select **Display then click the Magnification** tab if it is not already the front tab. From this dialog box it is possible to set horizontal and vertical size, whether the text is proportional (e.g. 3X [Horizontal] by 3X [Vertical] or not, and whether the text is to have smoothed edges, possible with 256 display monitors).

**Choosing Display Style**
From the ZoomText menu bar: From the **Window** menu select the display desired. The default view is **Overlay**. This view places a window in the lower right quarter of the screen. Cursor and Pointer tracking are on. Moving the mouse pans the screen display in this viewing window. The remaining 75% of the screen remain at normal magnification.

There are five main display options: Full Screen, Lens (a movable, sizable rectangle), H-split (horizontal split) and V-Split (vertical split).

**Overlay**
The default setting for ZoomText places the Overlay window in the lower quadrant of the screen. Moving the mouse pans the screen; with tracking on, activities using the cursor and mouse are focused in the window.

**Re-sizing the Overlay View**
It may be useful for students with learning disabilities to re-size the overlay so that only one line of text is magnified. This environment can be used for writing or reading. To do this:

1. Bring up the User dialog box with Alt Insert or with Shift Control U.
2. Select the Re-size icon (the 1st from the left in the lower row of Tool icons.)
3. Click the mouse pointer on one of the rectangular "handles" which now appear on the outline of the current overlay window.
4. Click and drag the window borders to the desired positions (left border to the left margin, lower border up a bit, top border down as far as possible, right border a little to the left, if necessary.) Click the right mouse button to keep the desired size.
**Full Screen**
For persons comfortable with the entire screen magnified. Moving the mouse (with tracking on) pans the magnified view.

**H-Split**
A magnified view of the screen is displayed in the lower half of the screen. Moving the mouse pans the view in the window. Cursor track places cursor activity in this view.

**Saving Configurations**
Configurations are easily saved or loaded into memory. Because a user can easily save a personalized configuration, it is easy to make ZoomText work in a highly customized setup.

**To Save a Setup**
1. Make necessary adjustments to ZoomText values.
2. Bring up the ZoomText User window with Alt Insert.
3. Open the File menu and select Save As.
4. Name the file (e.g., suzy). ZoomText automatically adds a .zxc extension.
5. The new configuration file is now listed at the bottom of the File menu, and can be loaded from there.

**Loading Configurations**
There are several different ways to load a configuration: From the File menu, select Open and select the file. Or from the File menu, select the name of the configuration from the bottom of the file menu if it is there. During a work session, once a configuration has been loaded, its name is placed at the bottom of the File menu.

**How to Scroll Text**
Having text scroll by in a magnified view can be an efficient way for some persons to read text. Entering the hot key command Ctrl Shift S brings up the Scroll icon. Click and hold down the mouse button and the screen starts the scrolling action in the direction of the mouse drag. Click the right mouse button or press Escape to leave the scroll mode.

**DocReader**
Note: To go to DocReader when in an open document (e.g., in Word) use the Ctrl Shift R hot key.

To explore the DocReader from the ZoomText window, do the following:
1. Click the DocReader button, the open book icon without the pointer, to launch DocReader to read text from the last active application. The
DocReader module is a reading environment that reformats, magnifies and speaks text (level 2 & 3 only) from any Windows application.

2. The text of the last opened application is reformatted into the DocReader window and a toolbar appears at the top. This toolbar is used to read through the text in a method similar to using a tape recorder’s buttons. Click on the first button to start reading through the enlarged text. Click it again to stop. For more detailed descriptions of the buttons, see the descriptions from the Help menu.

3. With Level 2, speech output is also possible and can be controlled either from the DocReader window or the icons on the application. The icons control the various aspects of the speech function. To learn each icon’s function, from the ZoomText Xtra application, click on the ? icon, then on the icon you wish to learn about. A short description will pop up which explains the function of that icon.

Notes:

**Level 1 Pricing**
- ZX Level 1 (for Windows 95/98 and 3.1) $395
- ZX Level 1 Plus (includes ZoomText for DOS) $595
- ZX Level 1 Upgrade * (from older ZoomText versions) $95

**Level 2 Pricing**
- ZX Level 2 (for Windows 95/98 and 3.1) $595
- ZX Level 2 Plus (includes ZoomText for DOS) $795
- ZX Level 2 Upgrade * (from ZX Level 1) $200
  (from older ZoomText versions) $195

**Site License Pricing**
Many site license options are available. For details, see the web site listed above.

**Installation**
ZoomText Extra Level 2 installation depends on which synthesizer option you will be installing. If you will be using a hardware synthesizer or if you have a SoundBlaster and TextAssist software installed, use the SSIL option during installation. If you choose the Windows sound card option, what you see next depends on what is already installed. If you have another Microsoft Speech Application Programming Interface (SAPI) software synthesizer installed, e.g., FlexTalk, you will see it listed along with TruVoice, the software synthesizer that comes with ZoomText Extra Level 2.

Currently, if you install TruVoice, your other SAPI synthesizers will become unavailable for your other applications. You may also have difficulty getting other SAPI synthesizers to work with ZoomText Extra Level 2. Until these
problems are resolved, we recommend using the SSIL hardware synthesizer or TextAssist option if you have it available. Another option is to install ZoomText Extra without speech on those computers that have other software synthesizers in use.

**Network**

This version allows users to specify both a directory for the hardware profile file, *ZxHdw.ini*, and the user configuration file, *Username.zxc*, so unique user settings can be preserved. This setup allows the program to be stored on a server, the local hardware profile to be stored on the local computer, and a particular user configuration to be stored on the server so that user has access to that configuration from any computer that has access to the server.

To do this, add the following to the command line of the ZoomText icon:

```
/c=c: \temp w:zt5 \users \username
```

where `/c=` is a switch to allow the following process, `a:` \temp is an example path to a directory that stores the local hardware profile file and `w:zt5 \users \username` is an example path to a directory on the server that stores `username's` configuration file. Note that there must be a space before the `/c=` \temp part and a space after that part to separate the two additions to the command line.

The names of ZoomText configuration files, which are loaded by LoadConfigFile hotkeys, are now stored in a global .INI file. This allows you to switch configurations without losing the configuration hotkey settings. A new file, ZXCFINLES.INI, contains the names of the hotkey configuration files and is stored in your ZoomText directory (or in the directory specified by the `/C.` command line parameter). This feature was added in version 6.01.